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Using this 
template  

The standard headings and tables in this template should be modified to meet the 
requirements of each Initial Assessment.  The sites may have diverse issues and 
constraints and problems and the standard template is therefore just a guide on 
typical requirements but flexibility is allowed to amend/ add headings as required 

 

 Hidden 
guidance  

The template contains various pieces of guidance covering content, use of tables 
etc.  The guidance is shown in blue text and can be turned ‘on’ to assist in the 
writing stages or ‘hidden’ for viewing or when printing the document.  You can 
switch between ‘hidden’ and ‘on’ and back to ‘hidden’ at any time. 

To show/hide the guidance click on the ¶ icon on the MS Word toolbar.  

If the hidden text does not disappear off the screen when the ¶ icon is clicked, go 
to:  Tools>Options>View Tab and uncheck the ‘Hidden text’ box.   

It is advisable to work with the hidden text turned on, as this helps to format new 
text and to avoid deleting the hidden text itself. 

 

Auto-
updating of 
contents 
page  

The contents page will update to reflect changed information in the main text and 
tables.  To update right click on the relevant area of the contents page, to highlight 
it, and select ‘Update Field” to access the update option. 

To enable these updating features to be created, the document contains specific 
text types and “fields”.  These are Headings 1, 2, 3 & 4; fields in the table labels 
and in the appendix labels.  When editing the document, take care to maintain 
these aspects. 

 

Inserting new 
headings  

To insert new headings in the main text go to: Format>Styles and Formatting to 
open the styles box. Insert the new headings, highlight it and click on the 
appropriate Heading level in the ‘Pick formatting to apply’ box.  Paragraph text 
can be inserted and formatted in a similar way. 

 

Inserting new 
tables  

Table labels should be added by Insert>Reference>Caption and selecting ‘Table’ 
from the drop down ‘Label’ box.  This will insert the Table title with the correct 
number and the caption can be typed in after the label.  Tables can then be cross 
referenced from the text by Insert>Reference>Cross Reference and selecting the 
appropriate reference type and caption from the drop down box and list. 

Initial assessment report  
Silsden Beck 
September 2016 
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Numbering 
paragraphs  

All paragraphs should be numbered sequentially as sub-sets of the section 
number. Prompts for paragraph numbering are provided as ‘Start writing here’ 
after which pressing <return> will automatically provide the next paragraph 
number.  
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1.1  Introduction and background 

In May 2016 CH2M were commissioned by the Environment Agency, on behalf of Bradford 
Metropolitan District Council, to undertake Yorkshire Area Initial Assessments report for Silsden 
Beck providing guidance on measures to reduce flood risk and potential funding availability. A 
site visit for this Initial Assessment was undertaken on 19th July 2016. This report has been made 
based on information from the site visit and previous studies and reports that are relevant to this 
Initial Assessment. 

 

1.1.1 Description of Location 

Silsden is a town and civil parish situated in West Yorkshire. The town is located at the 
intersection of the Leeds & Liverpool Canal and Silsden beck. It lies in the catchment of the River 
Aire, approximately 1 km upstream of the Silsden Beck confluence with the River Aire. The town 
has an estimated population of approximately 8250 people. 

During the Boxing Day 2015 flood event, most of the town, especially the centre, was affected by 
flooding. The principal source of flooding has been identified as two low points located between 
Cobby Bridge and the weir (Locations of identified low points are shown in Appendix E – Figure 
2).  During rainfall events the site is affected by surface water runoff from the nearby playing 
fields.  

According to the Index of Multiple Deprivation (IMD), this area is amongst the 40% least deprived 
neighbourhoods in the country. 

A location plan is shown in Appendix E – Figure 1. 

1.1.2 Description of Watercourses and Geology 

Silsden Beck is a small watercourse that flows between Silsden Reservoir and the River Aire 
over a length of approximately 3.6 km. The Silsden beck catchment area is 13.4km2, which has 
been considerably modified for flood defence purposes. 

1.1.3 History of Flooding 

Major historic flooding in the Aire catchment occurred in 1775, 1866 and 1946. Minor events 
occurred in 1967, 1980, June 2000, October/November 2000, February 2002 and August 2002, 
and July 2007.  

Specific information for Silsden beck is not available.  

1.1.4 Summary of Modelling Analysis 

In 2001, the Upper and Lower Aire Preliminary Strategic Reviews concluded that a combined 
hydrological-hydraulic model was required to better understand the flooding mechanisms in the 
catchment and to support the development of a comprehensive strategy to manage flood risk to 
communities in the floodplain. 

In 2001, Atkins were commissioned to deliver Phase 1 of the River Aire Modelling Study. Phase 1 
involved the collection of new topographic survey and hydrometric data, estimation of flows using 
the methods detailed in the Flood Estimation Handbook (FEH) and construction and calibration of 
a hydrodynamic model of the River Aire and associated floodplains. This further lead onto the 
development of a robust calibrated model, which was then used to undertake a series of design 
runs. 
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The River Aire model reach was defined from Gargrave at its upstream extent, down to its 
confluence with the River Ouse downstream of Airmyn. In order to accommodate this long 
stretch, the River Aire was subdivided into the following three reaches and modelled accordingly: 

• “Upper Aire” - from upstream of Gargrave Bridge to Leeds Station Weir (FDMS 
reaches 16-29) 

• “Lower Aire” - from Leeds Station Weir to Fairburn Ings (FDMS reaches 12-15) 
and the Lower Calder from Stanley Ferry to its confluence with the Aire (FDMS 
reaches 1-3) 

• “Tidal Aire” - from Fairburn Ings to the River Ouse at Airmyn (FDMS reaches 1- 
11) 

The final three models combined to form a catchment wide one-dimensional hydrodynamic (ISIS) 
model which was deemed to effectively capture the flow attenuation within the catchment. The 1 
in 100 year fluvial and 1 in 200 year tidal design flood levels were key deliverables from this 
study, which was completed in autumn 2004. This work formed the basis for the Upper Aire Flood 
Risk Management Strategy which aimed to define flood risk within this area and identify potential 
flood risk management options. The FRMS proposed flood risk management options for the 
medium and term, which included progressing a flood management scheme for defences at 
Silsden.  

The existing hydraulic model has allowed for climate change up to the year 2105 with a 30% 
increase to the hydrological inflow. However the guidance for climate change analysis has been 
updated since the Upper Aire Modelling Study and therefore these results are now outdated. 
Climate change modelled flood outlines were not considered in this initial assessment with 
analysis using present day outlines to assign flood risk bands. The model has not been calibrated 
since the work undertaken in 2002-2004 and should be updated including recent events, if the 
scheme progresses to OBC stage. 

1.1.5 Drivers, Constraints, Opportunities 

Silsden is within the area of the River Aire Catchment Flood Management Plan (CFMP), issued 
by the Environment Agency in 2010, and is covered by sub-area 3 Worth and Aire. The 
designated policy for residential areas at risk is Policy Option 5: areas of moderate to high flood 
risk where we can generally take further action to reduce flood risk. This policy will tend to be 
applied to those areas where the case for further action to reduce flood risk is most compelling. 
The CFMP vision is to improve the co-ordination between the several organizations that manage 
the different source of risk. 

The following drivers, constraints and opportunities have been identified within the study area.  
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Political Drivers  Summary Description 

Catchment Flood Management Plan River Aire CFMP 2010 

Catchment Flood Management Policy 

Policy 5: Areas of moderate to high flood risk 

where we can generally take further action to 

reduce flood risk 

Economic Drivers   Summary Description 

Enable Development 

There is potential development at this site but 

is dependent on flood risk and the outcome of 

this options analysis. 

Technological Drivers  Summary Description 

Improved Public Safety Via reduced flood risk.  

 

1.2 Problem and objectives 

 

1.2.1 Problem 

Site observations from local residents state that during the December 2015 flooding, high river 
levels inundated the study area at several locations, particularly at the two low points detailed in 
Section 1.1.1. The flow overtopped the left bank low point, flowed southwards down St. John’s 
Street inundating the properties on either side of the street. During the Boxing Day rainfall event, 
circa 340 residential and commercial properties were flooded. 

Other damage was caused by a significant amount of surface water cascading down from playing 
fields. The flow was blocked by a wall on St John’s Street that took the full force of the flow 
resulting in part of St John’s Street and the riverside wall being seriously damaged. The structural 
integrity of the wall is also compromised by a large tree that is growing through it.  

This initial assessment focuses on fluvial issues in Silsden and in particular the current condition 
of the linear defences along Silsden Beck’s left bank, adjacent to Silsden Weir. If the proposed 
options are progressed beyond initial assessment stage, further modelling will be required in 
order to assess the surface water problem at this site. 

1.2.2 Objectives 

The primary objective of this initial assessment is to undertake a scoping study for the area to 
identify the flood risk issues and viable solutions for the affected properties in order to reduce the 
flood risk.  

The aim is to identify the most cost beneficial option for addressing flood risk at this site. The 
purpose of this report is to lay the groundwork and, where applicable, provide a business case for 
future appraisal. The report aims to achieve the following: 

• Confirm the need for a project; 

• Identify the issues and Political, Environmental, Societal, Technological, 
Legislative and Economic (PESTLE) drivers and opportunities related to 
the need; 

• Identify the options to address the need and problem; 
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• Demonstrate that viable options exist based upon the available information; 

• Provide sufficient information to allow the packaging and optimisation of 
packages of future appraisal, design and construction packages; 

• Provide sufficient information for the appraisal scope to be prepared; 

• Make an assessment on the deliverability of the project; 

• Provide a basis/starting point for discussion with communities and partner 
organisations for use in the development of potential schemes and 
negotiations regarding funding contributions. 

 

1.3 Benefits 

The primary benefit associated with a reduction in flood risk would be the reduction in economic 
damages to properties. This would result in the reduction of disruption to local transport, 
businesses, schools and other infrastructure. 

The properties at risk include residential, commercial and public buildings. 

Social benefits relate primarily to a reduction in stress, health effects (including risk to life) and 
loss of memorabilia for those at risk. 

An appraisal period of 100years is assumed, over which the current standard of protection of 
existing assets is expected to decrease as a result of climate change. This appraisal assesses 
the current asset to ‘maintain the current standard of protection’. In order to quantify the benefits 
of a scheme, Flood Map for Planning (Rivers and Sea) – Flood Zone 2 was used in order to 
assess which properties are at risk of flooding. In addition NaFRA data was used to define the 
current flood risk associated to the properties in the benefit area. The properties were classed 
into the Very Significant, Significant and Moderate risk bands.  It was assumed that properties in 
1in20 year (5%) Annual Exceedance Probability (AEP) and higher were at Very Significant risk, 
properties which fall between 1in20 year (5% AEP) and 1in75 year (1.3%  AEP) were at 
Significant risk, properties between 1in75 year (1.3%  AEP) and  1in200 year (0.05% AEP) were 
at Moderate risk and 1in200 year (0.05% AEP) and lower were at Low risk.  A more detailed 
methodology for this benefit assessment, and the assumptions made, are included in Appendix 
D. 

This assessment only considers benefits for a scheme which addresses fluvial issues. Although 
there are surface water problems at this site, there is insufficient information to be able to quantify 
benefits associated with schemes focusing on surface water. If the proposed options are 
progressed beyond initial assessment stage, it is recommended that further modelling is 
undertaken to consider surface water problems. 

Table 1.1 Number of Properties at Risk (based on current outlines) 

Property Type Flood Risk Number of 
Properties 

≥1 in 25 year (4% AEP) 

(Very Significant Risk) 
0 

<1 in 25 year (4% AEP) 

≥1 in 75 year (1.33% AEP) 
(Significant Risk) 

46 Residential  

<1 in 75 year (1.33% AEP)  

≥1 in 200 year (0.5% AEP) 
179 
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(Moderate Risk) 

≥1 in 25 year (4% AEP) 

(Very Significant Risk) 
1 

<1 in 25 year (4% AEP) 

≥1 in 75 year (1.33% AEP) 

(Significant Risk) 

16 
Non-Residential 

<1 in 75 year (1.33% AEP) 

≥1 in 200 year (0.5% AEP) 

(Moderate Risk) 

30 

The property count showing in Table 1.1 is based on NaFRA data. Due to the current condition of 
the wall on the left bank of Silsden Beck, we believe that properties are at higher risk. Therefore, 
for the Do Nothing and Do Minimum scenario have been assumed by shifting properties into a 
higher risk band. 

 

1.4 Options 

A long list of options has been compiled for the study area and is summarised in the table below. 
The table shows the range of options considered and the reasoning for or against them being 
taken forward to the short list of options to be assessed. 
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Category Long List Option Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

Do nothing Do nothing All operational and 
maintenance 
activities cease 

Yes Required to support development 
of business case and benefit cost 
ratios. 

Do minimum Do Minimum Continue with 
current operational 
and maintenance 
activities: channel, 
weir and wall 
maintenance. 

Yes Represents current approach to 
asset maintenance and repair. 
Minor works to retain necessary 
performance. 
 

Non-structural 
(by EA) 

Improved flood warning Enhanced flood 
warning to allow 
residents to prepare  

No Fluvial warning was issued but 
there is the need to align warning 
to include surface water. 

Non-structural 
(by EA) 

Flood action plans Improved direction 
of reactionary flood 
defence measure 
(fire crews, 
temporary pumps, 
etc.) 

No The study area is already within a 
Flood Alert area operated by the 
Environment Agency. 

Property level protection Property level protection Protection to 
individual properties 
(e.g. via air brick 
covers, door guards 
etc).  

Yes PLP is assumed to be viable for 
all ground floor residential 
properties in the very significant 
risk band. However, the depth of 
flooding at these properties would 
have to be analysed at the next 
stage, as PLP is only suitable 
where the flood depth is less than 
500mm and duration less than 3 
days.  

Operational 
(by Others) 

Improve operation/design  Improve 
operation/design of 
assets not owned 

Yes There is a privately owned wall 
along Silsden Beck that is in 
need of imminent repair. This wall 
could be replaced by a formal 
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Category Long List Option Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

by the EA flood defence with a scheme 
which prevents impoundment / 
obstruction of surface water flows 
into the beck.  

Urban drainage Improve urban drainage. Improved surface 
water drainage 
system. 

Yes Implementing surface water 
drainage scheme to allow any 
overland flow to drain back into 
the river immediately downstream 
of the weir where there is 
capacity (see option 3 in the short 
list of option) 

Structural Flood Wall Bank raising Yes Filling in two low spots upstream 
of weir to reduce overtopping. 
This does not address the current 
condition of the wall. To be 
considered in combination with 
another option (Improve 
Operation/Design) 

Structural Conveyance Channel deepening 
or widening, 
including routine 
dredging. 

No No space to accommodate this. 

Structural Conveyance River restoration 
and/or pinch point 
improvements 
(bridges, culverts 
and weirs) 

No The efficiency of the weir is not 
judged the reason of the flooding  

Flood storage area  Online Use of active 
structures and re-
profiling to store 
water online.  

Yes Utilise Yorkshire Water Reservoir 
as a flood storage area. A study 
is ongoing as part of Yorkshire 
Water Price review 2019. 
Although data is not available for 
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Category Long List Option Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 
this option currently, this option 
should be considered for any 
future appraisal. Further 
information has been detailed in 
section 1.4.1. under option 5. 

Flood storage area Offline Gravity or pumping 
to offline storage 
area 

No There is not sufficient space to 
create FSAs of the required size 
in or near the study area. 
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1.4.1 Shortlisted Options Description 
The options below were chosen to be taken forward for assessment in the initial assessment 

 

Do Nothing  

The Do Nothing option is defined as taking no action whatsoever; under this option all 
management activities would cease, including maintenance and repair work to existing assets.  

There could be some advantages of this option in the form of habitat creation due to wetting of 
dry areas and naturalisation of channel, however, this is also likely to increase the risk for the 
urbanized areas. 

The Do Nothing option is not to be taken forward as a viable option (progressed for 
benchmarking only) as it results in an unacceptable increase in flood risk to people and property 
due to failure and deterioration of assets and blockages to the channel.     

Do Minimum 

The Do Minimum option is defined as the minimum level of action or intervention necessary to 
sustain the standard of service (SOS) presently offered throughout the study area. It will form the 
appraisal baseline.  

This option assumes continuation of the existing maintenance regime.  This includes 
maintenance requirements for existing structures and assets, channel maintenance, operation 
and maintenance of weirs and other in-channel structures and where possible, existing non-
structural measures such as flood forecasting and flood warning.  

The advantage of Do Minimum is that it sustains current standard of service within the study area 
and there are no increase in costs associated with this option.  

The disadvantages of Do Minimum is that the current maintenance regime is not believed to 
significantly reduce the flood risk to people and properties in the study area. It does not account 
for the increase in flood risk due to climate change. A further solution would therefore be required 
in order to reduce the effect of higher frequency flood events.  

Due to the current condition of the wall on the left bank of Silsden Beck, the Do Minimum option 
will require an initial intervention to repair the damaged wall in order to sustain the standard of 
service as defined above. The works assumed for this intervention are as detailed in Option 2 
(however the two low points in the banks will not be addressed here). 

There are no indicators to suggest that this option is non-viable or undeliverable.  

Option 1: Property Level Protection 

This option is to offer property level protection (PLP) to the 46 ground floor residential properties 
in the Significant risk band. PLP can take the form of barriers in doorways, non-return valves 
fitted to drains, and airbrick/vent covers. Properties can also be made more flood resilient, using 
waterproof plaster, solid concrete floors or tiled floor coverings in order to reduce the amount of 
time and money needed to recover from a flood event. PLP is generally used as an option for 
properties that experience less than 500mm of flooding. 

Advantages of this option include the fact that defences have minimal visual and land impact, and 
do not remove any of the flood plain area. PLP will protect against surface water as well as fluvial 
flooding. Any changes would need to be in keeping with surroundings. 
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Disadvantages of this option include the requirement for residents to receive sufficient alert and 
for them to be available and educated in deploying PLP measures. Furthermore, PLP does not 
provide any wider environmental benefits and does not prevent the flooding of areas surrounding 
the property. The effectiveness of PLP reduces with long duration floods due to seepage. 
Deliverability of this option is reliant on the resident’s take-up of PLP. 

For the purpose of this IA, this option has been assessed for 46 properties which are currently in 
the Significant risk band (according to NaFRA), however further modelling is recommended to 
better understand if there are any properties at high risk of flooding which will be eligible for 
FDGiA funding. 

Option 2: Wall replacement to existing standard of protection 

This option focuses on the current condition of the wall which runs along the left bank of Silsden 
Beck. The damaged wall is approximately 80m in length and from initial judgement at the site visit 
for this initial assessment, the first 60m needs to be completely replaced and the remaining part 
requires only a partial refurbishment. If this option is considered in future, structural surveys will 
be required to confirm the length of wall requiring full replacement. The damage was caused by 
the high energy flow that originated from the Mitchell Lane area, and increased hydrostatic 
loading on the wall.  

This option is a permanent option and does not require operation. It consists of the replacement 
of the damaged wall for a length of approximately 60m with a 12m sheet pile wall. Considering 
the poor condition of the remaining portion of the wall, it is also recommended to refurbish the top 
of the remaining part for a length of 20m with a reinforced concrete wall, 1,5m high.   

The wall replacement and refurbishment will be to the same height in order to maintain the 
existing standard of protection. The current standard of protection is not known, however based 
on NaFRA data, a standard of protection of 1in50 year (0.2% AEP) has been assumed for the 
purpose of this initial assessment. Should this work be progressed beyond this stage, it is highly 
recommended that further modelling is undertaken to understand the flood risk in the area and 
provide a more accurate benefits assessment. 

Site observations from local residents, verified by a review of crest levels, show that the majority 
of the flooding came from the two low points just upstream of the weir. Part of this option involves 
continuing the wall, on both the sides of the river, where the two low points are located. Locations 
of identified low points are shown in Appendix E – Figure 2. 

It is highly recommended to increase the number of outfalls in the wall in order to allow surface 
water drainage to discharge into the beck. 

Option 3: Wall replacement to improve standard of p rotection to 1in100 year (1% AEP) 

This option is similar to Option 2, however the height of the wall on the left bank of Silsden Beck 
will be increased to provide a standard of protection of 1in100 year (1% AEP).  

Due to limited data, it is not fully understood at this stage if increasing the height of the wall will 
increase flood risk on the opposite bank. For the purpose of this initial assessment, a fixed cost of 
£100k has been assumed to cover any required works on the right bank of Silsden Beck as a 
result of this option. It is recommended that for any future appraisal further hydraulic modelling is 
carried out to understand the flood risk caused by increasing the height of the defences on the 
left bank. 

Option 4:  Improve urban drainage 
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This option will attenuate the surface water run-off from the playing fields at Mitchell Lane. This 
will consist of building a 200m embankment around the playing field to form a basin to store 
surface water. This will require 550m of pipeline to allow this basin to drain into Silsden Beck.  

This option increases flooding to the playing fields during a flood event. However this is not 
thought to be a significant impact as the field will only be flooded during exceptional events.  

This basin will need periodical maintenance work such as debris removal, grass cutting and 
management of the vegetation. 

Previously, Yorkshire Water had some serious issues with their networks within this area. After  
sewage flooding in 2011, the Keighley Low Level Drainage Area Plan has been prepared by  
Yorkshire Water Services, Environment Agency, Aire River Trust and councillors. 

This option will not be assessed further as part of this initial assessment because there is 
insufficient information available in order to assess the flood risk due to surface water. However, 
should this initial assessment be progressed to outline business case and beyond, further 
modelling should be undertaken to better understand the surface water problem in this area. 
Yorkshire Water is interested in a partnership opportunity and would be happy to provide a 1D-1D 
sewer model for the Keighley Lower Drainage Area within any further studies. 

Option 5: Flood Storage (Silsden Reservoir) 

Silsden Reservoir has been identified as a potential storage reservoir to attenuate fluvial flood 
waters.  

The impact of using Silsden Reservoir as a storage area could be a reduction in flood risk, 
however this is uncertain.  The Environment Agency would have to undertake detailed hydraulic 
modelling to understand whether altering the way the reservoir is operated could provide a flood 
risk benefit.  

In operating the reservoir for flood risk management, there may be serious implications for 
reservoir safety and compensation flows in the downstream catchment. 

A study is ongoing with Defra, the Environment Agency, Yorkshire Water and United Utilities to 
understand what potential there is across the region for using reservoirs for flood storage, whilst 
also taking into account drinking water supply, reservoir safety, and other risks. This option could 
be used in conjunction with other options, for example repairing the flood defences. 

At this stage, there is insufficient information to fully assess the costs/benefits of this option. 
Therefore, the economic analysis for this option is not presented in this report but the option 
could be considered in any future studies. As a first step, the Environment Agency would have to 
undertake detailed hydraulic modelling to understand whether the reservoir could provide a flood 
risk benefit. Should it be shown that some flood risk benefit could be provided, a range of other 
issues would also have to be considered before any such option could be progressed. Amongst 
other issues, consideration would have to be given to reservoir safety and the future ability to 
provide environmental compensation flows into the downstream catchment. A regional study is 
ongoing with Defra, the Environment Agency, Yorkshire Water and United Utilities to understand 
these wider issues. The costs of any work required to modify the reservoir to allow its use for 
flood storage would have to be assessed in the same way as any other flood mitigation options. 
Further, any such costs would have to be funded through FDGiA or similar sources, not through 
Yorkshire Water bills. 

 

1.4.2 Costs of options 
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The costs for the options were provided by the Environment Agency and were calculated using 
the Environment Agency’s Project Cost Tool and Long Term Costing Workbook. The 
maintenance and operation costs relate to maintenance to assets to target condition 3, carried 
out mechanically. The maintenance and operation costs are outlined in Appendix A. 

It is assumed that a major replacement of assets will be required at some point during the 
appraisal period after the initial construction phase. The timing of these replacements is based on 
the EA’s Asset Deterioration Guidance (2013), an appraisal period of 100 years has been used 
and the assumptions are outlined in Appendix A. Table 1.1 show the initial cost of the option. 

Table 1.2 Project costs (£k) 

Item Do Min Option 1 Option 2 Option 3 

Construction Base Cost   353 197 403 

Environment Agency staff  56 31 64 

Consultant fees (appraisal) 23 13 26 

Consultant fees (design) 77 43 87 

Consultant fees (construction) 20 11 23 

Surveys (Ground investigation) 4 2 4 

Surveys (Archaeological) 
 

1 
0 2 

Land purchase  0 0 0 

Sub-total  533 298 609 

Optimism Bias 234 131 268 

*Assume same 
cost as Option 2 
with additional 

£100k for 
additional works 
on right bank (as 
detailed above in 

shortlisted 
options) and 

additional £100k 
as an initial 
estimate for 

height increase 
in wall 

TOTAL 767 429 877 1077 

Annual Maintenance costs 0.68 0.65 0.68 0.68 

 

* These costs will need to be calculated more accurately for any future appraisal. 

 

1.5 Initial environmental assessment 

Table 1.3 Key environmental impacts, mitigation and opportunities 

Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

Option 1 

• Reduced risk of fluvial 
flooding 

• Low risk of pollution 
incidents and 
disruption to area 
during construction. 

 

• Reduced risk of fluvial 
damages only up to 
1in75 year (1.33% AEP) 
events. 

• Aesthetic impacts 

• A large proportion of 
the benefit area 
assumed for this initial 
assessment lies within 
the Silsden Conservation 
Area 

• Best practice should be 
followed including referring 
to EA Pollution Prevention 
Guidance 

Option 2   
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Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

• Reduced risk of fluvial 
flooding 

 

• Construction work takes 
place alongside 
watercourse. Risk of 
pollution incidents and 
disruption to area during 
construction 

• Aesthetic impact in 
removing low spots in 
wall  

• A large proportion of the 
benefit area assumed for 
this initial assessment 
lies within the Silsden 
Conservation Area 

• Possibly temporary 
increase to 
noise/vibration levels 
during construction 

• Best practice should be 
followed including referring 
to EA Pollution Prevention 
Guidance 

• It is recommended that 
adverse impacts should be 
minimised as much as 
possible through the 
adoption of ‘best 
practicable means’ as 
defined in the Control of 
Pollution Act 1974 to 
minimise noise and 
vibration resulting from 
construction operations and 
shall have regard to British 
Standard BS 5228 1997 
code of Practice for Noise 
Control on Construction 
and Open Sites. 

 

1.6 Consultation 

The options in this appraisal were developed in consultation with the Environment Agency and 
Bradford MDC. No public consultations were held at this stage as the work is a high-level 
assessment of potential options. Stakeholder engagement will take place at subsequent stages of 
the project. 

If this project is taken forward for further appraisal it is recommended that consultation is focused 
on, but not limited to, the following: 

• Statutory Stakeholders 

• Residents in the area at risk 

• Landowners and developers for the upstream storage option (Option 5). 

• Riparian landowners, especially owners of riverside walls acting as informal defences. 

A study is ongoing as part of Yorkshire Water Price review 2019 regarding the use of the Silsden 
Reservoir as a flood storage area. If this option, which is not assessed here, is feasible, then 
consultation with the Yorkshire Water will be required.. 

 

1.7 Economic summary and preliminary preferred opti on 

Table 1.3 summarises the economic assessment carried out for all options. The calculations for 
PV benefits are shown in Appendix D. 

 

Table 1.4 Benefit-cost assessment  

 PV costs 

(£k) 

PV benefits  

(£k) 
Av. BCR Incr’ BCR  Option for iBCR 

calc  
Comments 

Do Nothing       
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Do Minimum  311.43 

Low:29 

Mid:39 

High:49 

Low:0.09 

Mid:0.13 

High:0.16 

 

N/A N/A 

 

Option 1 1,389.92 

Low:1100 

Mid:1500 

High:1900 

Low:0.79 

Mid:1.08 

High:1.37 

 

1.35 Do Minimum 

 

Option 2 969.62 

Low:268 

Mid:357 

High:447 

Low:0.28 

Mid:0.37 

High:0.46 

 

0.48 Do Minimum 

 

Option 3 1,186.17 

Low:1300 

Mid:1800 

High:2200 

Low:1.10 

Mid:1.52 

High:1.85 

 

2.01 Do Minimum 

This is the preferred 
option with the 
highest ABCR 

 

Option 3 is the preferred option with the highest ABCR. Option 3 has been taken forward. 
Preliminary estimates for Partnership Funding scores have been calculated and are shown in 
table 1.4. However, its benefit period for the Partnership Funding calculator is reduced to 70 
years, as a major investment of greater than 20% of the initial capital cost will be needed at that 
stage. The calculations of the revised PV costs, PV benefits and PF score for Option 3 is shown 
in Appendix C, and summarised below. 

 

The maximum grant rate for the Partnership Funding calculations has been reduced to 45% as a 
strategic approach has not been taken for the benefits assessment. For future appraisal, it is 
recommended that hydraulic modelling is carried out to better understand the surface water 
problem at Silsden and the results should be used to estimate benefits based on average depths. 

 

 

Table 1.5 Benefit-cost ratios and outcome measures  

Contributions to outcome measures  Option 2 

OM1 – Economic Benefit:   

    Benefit period used for Partnership Funding calcs 70 

    PV Benefits 

Low:£900,000 

Mid:£1,200,000 

High:£1,600,000 

    PV Costs £1,095,520 

    Benefit/Cost ratio 

Low:0.82 

Mid:1.10 

High:1.46 

OM2 – No. of households moved out of any flood 
probability category to a lower category 

225 

OM2b – No. of households for which the probability of 
flooding or coastal erosion is reduced from the very 
significant or significant category to the moderate or low 
category 

0 

OM2c – No. of households in the 20% most deprived 
areas moved from the very significant or significant flood 
probability category to the moderate or low category  

0 

OM4a – Hectares of water dependent habitat created or 0 
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improved to help meet the objectives of the Water 
Framework Directive 

OM4b – Hectares of intertidal habitat created to help 
meet the objectives of the Water Framework Directive 
for areas protected under the EU Habitats/Birds 
Directive  

0 

OM4c – Kilometres of rivers protected under the EU 
Habitats/Birds Directive improved to help meet the 
objectives of the Water Framework Directive 

0 

Partnership Funding (PF) Score  9% 

Contributions required for a PF score of 100% £997,142 

Contributions required for a PF score of 120% £1,013,500 

 

 

 

1.7.1 Funding and contributions 

A funding analysis tool was used to identify potential direct and indirect beneficiaries of the 
scheme. This is included in Appendix C. Based on these beneficiaries potential funding sources 
identified include: 

• Community Infrastructure Levy 

• Benefitting local businesses 

• Local Enterprise Partnerships 

Further consultation would be required to identify potential contributions 

1.7.2 Key delivery risks (economic, social and envi ronmental) 
 

Table 1.6 Risks and mitigation  

Risk Key Mitigation 

Inaccurate benefits assessment due to limited 
understanding of flood risk hence unreliable 
approach to economic damage calculations used for 
IA’s. 

A more accurate damages assessment based 
on hydraulic modelling and flood depth 
damage data should be considered before 
progressing to further appraisal. 

Risk of pollution incidents and disruption to area 
during construction 

Best practice should be followed including 
referring to EA Pollution Prevention Guidance 

Risk of reducing the aesthetics of buildings (PLP) When considering resistance measures keep 
in mind their impact on aesthetics of buildings 
(PLP) 

Insufficient 3rd party Funding available to allow 
scheme to progress. 

Assess potential funding options before 
progressing scheme appraisal further. 

 

1.8 Further work requirements 

If the project is taken forward for further appraisal, it is recommended that the following work is 
carried out: 

• Investigate the potential of using Silsden Reservoir as a storage option. Consultation with 
Yorkshire Water will be required on completion of the Yorkshire Water Price review 2019 
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to understand the outcome of the study and the feasibility of the option. Investigate the 
feasibility of using Silsden Reservoir as a flood storage area.  Modelling work would be 
needed to understand the impact that lowering levels in Silsden Reservoir would have on 
flood risk downstream. A study is ongoing with Defra, the Environment Agency, Yorkshire 
Water and United Utilities to understand what potential there is across the region for using 
reservoirs for flood storage, whilst also taking into account drinking water supply, reservoir 
safety, and other risks. The outcomes of this work would be needed to assess the 
feasibility of this option. 

• Option 2 and 3 – Further hydraulic modelling will be required to understand the current 
standard of protection of the existing wall and better quantify the benefits the proposed 
options will bring. The modelling scenarios should include lower order events to 
understand the viability of raising the existing wall and providing a standard of protection 
to 1in100 year (1% AEP) plus climate change and 1in200 year (0.5% AEP) plus climate 
change. 

• Further investigation into the surface water issue in Silsden. Modelling should be 
undertaken to understand how much surface water contributes to flood risk in this area. 
Yorkshire Water is interested in a partnership opportunity for upstream storage at Mitchel 
Lane. They would be happy to provide a 1D-1D sewer model for the Keighley Lower 
Drainage Area with further studies, so it can be integrated with a model which could look 
at the overland flow of flood waters. 
 

Table 1.7 Programme Key dates 

Gateway Activity Complexity Duration (months) Estimated Date 

G0 Initial Assessment Complete - - 

G1 Project start date   January 2017 

 

Hydraulic Modelling to 

update IA and inform 

SOC Medium  

6 

June 2017 

 Strategic Outline Case Medium 6 December 2017 

 Outline Business Case Medium 4 April 2018 

G2 Detailed Design Medium 12 April 2019 

G3 
Financial Business 

Case /Contract Award 

Medium 
6 

October 2019 

G4 

Construction 

Completion 

Medium 
12 

October 2020 

G5 Handover Medium 24 Octobrer 2022 

 

 

1.9 Conclusions and Recommendation 

The main risk of flooding in Silsden is fluvial from overtopping of the river banks in the low spots 
immediately upstream of Silsden Weir. There was significant flooding during December 2015 
from Silsden Beck. 

 

Option 3, is the highest scoring Do Something option. For the purpose of this assessment, the 
option has been proposed to improve the existing standard of protection to 1in100 year (1% 
AEP). However, it is recommended that further modelling is undertaken to better understand the 
current standard of protection in order to better estimate the benefits of increasing the height of 
the wall. 
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It is recommended that further work be undertaken to assess the feasibility of option 5; using 
Silsden Reservoir for flood storage, should this initial assessment be progressed further. 

There is also a risk of pluvial flooding in Silsden. During the December 2015 flood event, 
significant damage was caused to the existing wall on the left bank of Silsden Beck due to 
surface water cascading down from the adjacent playing fields. Options 2 and 3 consider 
increasing the number of outfalls which will allow surface water to drain into the beck, however 
due to insufficient information of pluvial risk in this area, option 4 improve urban drainage has not 
been assessed as part of this assessment. It is recommended that further modelling is carried out 
to better understand the pluvial flood risk in Silsden. Potentially, Yorkshire Water would be 
interested in a partnership opportunity to work towards developing option 4 – improving urban 
drainage. 
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Appendices 


